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1  WYMOGI BEZPIECZEŃSTWA

Poniższe  wymogi  bezpieczeństwa  nie  zawierają  wszystkich  informacji  dotyczących
działaniaurządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości!

UWAGA: Wszelkich  podłączeń  i  zmian  należy  dokonywać  przy  odłączonym  napięciu
zasilającym.

UWAGA: Instalacja  oraz  programowanie  urządzenia  wymagają  posiadania  odpowiednich
umiejętności,  dlatego  mogą  być  dokonywane  tylko  przez  wykwalifikowany
personel po zapoznaniu się z całą instrukcją obsługi.

UWAGA: W przypadku,  gdy urządzenie ulegnie  uszkodzeniu,  należy  skontaktować się  ze
sprzedawcą lub osobą odpowiedzialną za instalację. 

UWAGA: Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu.

UWAGA: Odpowiedzialność  za  prawidłową  instalację  urządzenia  spoczywa  na  osobie
montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy
obowiązujące w danym kraju. 

UWAGA: Wyładowania  elektrostatyczne  mogą  uszkodzić  urządzenie.  Należy  stosować
odpowiednie zabezpieczenie.

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują
utratę gwarancji. 
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2  Wstęp

Moduł MCP-1P służy do pomiaru ciśnienia w zakresie 300-1100[hpa]. Dokładność pomiaru
ciśnienia w zakresie 7500-1100[hpa] wynosi ±1,5[hpa], zaś rozdzielczość 0,1[hpa]. Moduł może
być zasilany napięciem od 9 do 24V prądu stałego (DC). Maksymalny pobór prądu wynosi 100mA
przy napięciu zasilania 24VDC i zależy od długości magistrali RS485, ilości świecących diod LED,
temperatury otoczenia oraz napięcia zasilania modułu. Wymiary modułu pozwalają na zmieszczenie
go w standardowej puszce instalacyjnej. 
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Rys. 2.1: Widok modułu MCP-1P



3  Dane techniczne

Nazwa parametru Uwagi Min. Max.

Napięcie zasilania Notka 1 7V 26VDC

Temperatura Notka 1 -20ºC 60ºC

Tabela 1: Parametry graniczne

• Uwaga:  Przekroczenie  parametrów  granicznych  może  spowodować  uszkodzenie
urządzenia,  lub/i  trwałe  obniżenie  parametrów.  Długotrwała  praca  w  warunkach
bliskich parametrom granicznym może spowodować nieprawidłowe działanie układu,
a nawet uszkodzenie urządzenia.

Nazwa
parametru

Uwagi Min. Typ. Max.

Napięcie zasilania 9VDC 18VDC 24VDC

Prąd zasilania 50mA 100mA

Temperatura pracy -20ºC 25ºC 60ºC

Wilgotność Notka 1 5% 95%

Wysokość 0m n.p.m. 2000m n.p.m.

Tabela 2: Rekomendowane warunki pracy

• Notka 1: Wilgotność bez kondensacji!
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4  Instalacja

 4.1 Obwód elektryczny
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Rys. 4.1: Schemat poglądowy modułu

Rys. 4.2: Rozmieszczenie elementów na płytce modułu, dostępnej po odkręceniu dekielka



D1..D3 – diody LED sygnalizujące stan urządzenia
SW100 – przełącznik konfigurujący prędkość komunikacji, adres płytki oraz tryb Modbus

• Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę
i/lub uszkodzenie urządzenia nie objęte gwarancją!

 4.1.1 Złącze J1

Złącze J1 zostaje nie podłączone. 

 4.1.2 Złącze J2

Numer wyprowadzenia Nazwa Opis

1 GND Minus zasilania modułu

2 +24VDC Plus zasilania modułu

3 D+ interfejs RS-485

4 D- interfejs RS-485

Tabela 3: Opis wyprowadzeń na złączu J2

 4.1.3 Diody sygnalizacyjne

D1(światło czerwone): Zasilanie CPU: miganie oznacza poprawną pracę urządzenia.
D2(światło zielone): Odbiór RS-485: miganie kontrolki oznacza odbieranie danych po RS-485.
D3(światło  czerwone): Nadawanie RS-485, miganie kontrolki oznacza wysyłanie danych 
                                           po RS-485.

Nieprzerwane świecenie  diod RX i TX sygnalizuje możliwość błędu w podłączeniu sygnałów  do
gniazda. Miganie tylko diody sygnalizującej odbieranie danych przez moduł sygnalizuje możliwość
wysyłania  błędnego  adresu,  lub  wybranie  błędnych  parametrów  transmisji  (nieprawidłowa
prędkość, ustawienia parzystości, liczba bitów stopu, itp.)
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Rys. 4.3: Widok konektora zasilająco-komunikacyjnego J2



 4.2 Przykład podłączenia elektrycznego

Poniższy rysunek przedstawia schemat typowego podłączenia układu do  magistrali RS-485. Moduł
pomiaru ciśnienia można zasilać napięciem stałym z zakresu 9...24V. 

Komunikacja modułu z innymi urządzeniami realizowana jest z wykorzystaniem protokołu Modbus
po  magistrali  RS-485.  Przewody  należy  podłączyć  według  rysunku  (rys.  .4.4). Moduł  może
pracować tylko jako urządzenie slave. Adres fizyczny urządzenia w protokole Modbus, prędkość
komunikacji i tryb Modbus (RTU/ASCII) ustala się przełącznikiem SW100, co zostanie opisane w
dalszej części instrukcji. 
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Rys. 4.4: Przykład podłączenia modułu pomiaru ciśnienia MCP-1P do sterownika



 4.3 Ustawianie prędkości, adresu i trybu Modbus 

 4.3.1 Ustawianie adresu Modbus za pomocą switcha SW100

W położeniu przedstawionym na rysunku, zworka w pozycji OFF oznacza 0, w pozycji ON – 1. 

W pzrełaczniku SW100 zworki 1..6 służą do ustawienia adresu w protokole Modbus:
1 – A0 (najmniej znaczący bit adresu - LSB),
2 – A1,
3 – A2,
4 – A3,
5 – A4,
6 – A5 (najbardziej znaczący bit adresu – MSB).

Adres modułu wyjść w protokole Modbus:
- ustala się sprzętowo za pomocą pzrełącznika SW100, 
- może przyjmować wartości 1..63, 
- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast), 
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Rys. 4.5: Switch SW100 do ustawiania adresu Modbus (zworki 1-6)Na rysunku przedstawiono 31
z 63 możliwych ustawień adresu.



-ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON to bit adresu
ustawiony jako 1. Switch w pozycji OFF to bit adresu ustawiony jako 0.

• Uwaga: Aby zmienić adres modułu w protokole Modbus, prędkość transmisji
lub tryb RTU/ASCII, należy ustawić żądane parametry, a następnie wyłączyć i
włączyć zasilanie. Zmiana parametrów przy włączonym zasilaniu nie odniesie
skutku. Nastąpi to dopiero przy ponownym uruchomieniu urządzenia.

 4.3.2 Ustawianie prędkości transmisji za pomocą switcha SW100.

Zworka 8 ze switcha SW100 służy do ustawiania prędkości transmisji:
OFF – prędkość 9600 bps
ON – prędkość 57600 bps

 4.3.3 Ustawianie trybu Modbus (RTU/ASCII) za pomocą switcha 
SW100.

Zworka 7 ze switcha SW100 służy do ustawiania typu Modbus:
OFF – RTU
ON – ASCII

• Uwaga: W module wyjść i urządzeniu nim sterującym muszą być ustawione takie same
parametry transmisji!
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5  Konfiguracja

 5.1 Protokół transmisji danych

Moduł  komunikuje  się  z  urządzeniem  sterującym  za  pomocą  protokołu  Modbus.  W warstwie
fizycznej  połączenie  jest  realizowane  za  pomocą  interfejsu  RS-485  2W,  half-duplex  (z
przełączaniem  kierunku  transmisji).  Rejestry  1100..1103  są  rejestrami  3x  –  Input  Registers,
natomiast wszystkie pozostałe to Holding Registers – 4x.

prędkość: 9600/57600 baud (przełączane zworką)

parzystość: Even

ilość bitów danych: 8

ilość bitów stopu: 1

Tabela 4: Parametry transmisji w trybie RTU

prędkość: 9600/57600 baud (przełączane zworką)

parzystość: Even

ilość bitów danych: 7

ilość bitów stopu: 1

Tabela 5: Parametry transmisji w trybie ASCII
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Numer rejestru Nazwa Opis

1100 Identyfikacja Rejestr do identyfikacji

1101 Wersja FW Wersja firmware modułu

1200 Temperatura Format całkowity temperatury

1201 Ciśnienie Format całkowity ciśnienia

1202 Błąd
Pojawienie się wartości innej niż 0

sygnalizuje błąd.

1203
Czas pomiędzy

odczytami
Odczyt ciśnienia przez czujnik 

np.  co 1s

1204 Temperatura float
Starszy bajt temperatury

skompensowanej

1205 Temperatura float
Młodszy bajt temperatury

skompensowanej

1206 Ciśnienie float
Starszy bajt ciśnienia
skompensowanego

1207 Ciśnienie float
Młodszy bajt ciśnienia

skompensowanego

1213
Stan przełącznika

SW100

Tabela 6: Rejestry Modbus i ich znaczenie w module ciśnienia

Adres 1100: 384  Numer identyfikacyjny MCP-1P

Adres 1101: 100 Wersja oprogramowania 1.0.0

Adres 1200: 244 Wartość temperatury 24,4ºC

Adres 1201: 1008 Wartość mierzonego ciśnienia 100,8 hpa

Adres 1202: 0 Brak błędów

Adres 1203: 2 Czas pomiędzy odczytami, ustawiany na 2s

Adres 1204: 7864 Float, starsze 16 bitów

Adres 1205: 16835 Float, młodsze 16 bitów

Adres 1206: 16525 Float, starsze 16 bitów

Adres 1207: 17032 Float, młodsze 16 bitów

Adres 1213: 1 Wartość na przełączniku SW100 ustawiona na 1

Tabela 7: Przykład
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Aby zobaczyć temperaturę i ciśnienie w czytelnym, znormalizowanym formacie, należy w tablicy
„StatusPage”  programu  WinProLadder  wypisać  w  postaci  „Floating”  wartości  podwójnych
rejestrów  DR  odpowiadających  skompensowanej  temperaturze  ciśnieniu.  Dla  powyższego
przykładu będzie to wyglądać następująco:

Ref. No. Status Data

Odczyt temperatury: DR1204 Floating 24,3899

Odczyt ciśnienia: DR1206 Floating 100,8

• Moduł docelowo jest przygotowany jedynie do odczytu ciśnienia, lecz możliwy jest również 
odczyt temperatury. Odczyt temperatury będzie jednak zafałszowany z racji tego, że czujnik ten 
znajduje się wewnątrz obudowy. Temperatura służy jedynie do kompensowania wartości 
ciśnienia. 

 5.2 Przykład podłączenia modułu do sterownika PLC Fatek

Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port
w sterowniku PLC. Możemy tego dokonać za pomocą programu  WinProLadder.  Wybieramy z
menu PLC → Setting → Port (numer portu, po którym będzie odbywała się komunikacja): 

Rys. 5.1: Wybór portu komunikacyjnego w sterowniku PLC
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Po wybraniu  odpowiedniego portu musimy go skonfigurować.  Ustawiamy parametry transmisji
w trybie RTU:

Prędkość (Baud Rate): 9600/57600 (ustawiane zworką) 
Parzystość (Parity) even
Ilość bitów danych (Data Bit): 8
Ilość bitów stopu: (Stop Bit) 1
Protokół Modbus RTU (slave)

Rys. 5.2: Konfiguracja portu komunikacyjnego sterownika PLC, w trybie RTU

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy parametry transmisji w
trybie ASCII:

Prędkość (Baud Rate): 9600/57600 (ustawiane zworką) 
Parzystość (Parity) even
Ilość bitów danych (Data Bit): 7
Ilość bitów stopu: (Stop Bit) 1
Protokół Modbus ASCII (slave)
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Rys. 5.3: Konfiguracja portu komunikacyjnego sterownika PLC, w trybie ASCII

Sterownik ustawiony jako „master” musi mieć uruchomioną funkcję M_BUS (funkcja 150).  W
funkcji  M_BUS (150)  użytkownik  ustawia  tylko  port,  którego  będzie  używał  do  komunikacji,
rejestr startowy programu do komunikacji oraz rejestr roboczy. 

Funkcja 150.M_BUS

Rys. 5.4: Symbol funkcji 150.M_BUS

Pt: Numer portu, który ma być użyty do komunikacji
SR: Rejestr startowy 
WR: Rejestr roboczy 
Jeżeli wejście A/R = 0   - protokół Modbus
Jeżeli wejście A/R = 1   - protokół Modbus ASCII
Jeżeli wejście ABT zmieni się na 1, operacja zostaje przerwana i po jej wznowieniu przesyłanie
zaczyna się od pierwszego pakietu danych.

\
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Kiedy już zostanie skonfigurowany port oraz wstawiona funkcja 150.M_BUS,  tworzymy tabelę. Z
menu wybieramy Project → Modbus Master Table → Add Modbus Master Table.

Rys. 5.5: Widok ekranu przy wstawianiu z menu tabeli do obsługi
Modbusa w programie WinProladder.

Rys. 5.6: Widok ekranu przy wstawianiu z drzewa konfiguracji
tabeli do obsługi Modbusa w programie WinProladder.

Po wybraniu Add Modbus Master Table pojawi się okno Table Edit. 
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Rys. 5.7: Okno konfiguracji funkcji Modbus w sterowniku FATEK.

W polu Table Name użytkownik może wpisać dowolną nazwę np. modbus, natomiast w
polu  Table  Starting  Address  należy wpisać  rejestr  startowy,  który został  użyty w programie  w
funkcji 150.M_BUS, np.: R1000. Następnie po pojawieniu się okna Modbus Master Table można
dodawać komendy. 

Rys. 5.8: Okno edycji komend w komunikacji Modbus.

Po naciśnięciu przycisku Add pojawia się okienko Command Item, w którym należy wprowadzić
numer stacji Slave Station (adres modułu), następnie wybrać rodzaj komendy (read/write), rozmiar

17



przesyłanych danych, adres startowy w sterowniku „master” oraz adres startowy w module.

Przykładowa konfiguracja (odczyt temperatury):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read (Odczyt)
Data Size: 2 (starsze i młodsze słowo temperatury)
Master Data Start Address: np.: R400 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401204 (początkowy rejestr odczytywany z modułu)

Przykładowa konfiguracja (odczyt ciśnienia):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read (Odczyt)
Data Size: 2 (starsze i młodsze słowo ciśnienia skompensowanego)
Master Data Start Address: np.: R402 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401206 (początkowy rejestr odczytywany z modułu)

Przykładowa konfiguracja (zmiana czasu odczytu):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Write (Zapis)
Data Size: 1 
Master Data Start Address: np.: R412 (zapisuje do modułu wartość z tego rejestru)
Slave Data Start Address: np.: 401203 (docelowy adres w module)

Przykładowa konfiguracja (odczyt błędu):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read (Odczyt)
Data Size: 1 
Master Data Start Address: np.: R413 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401202

Przykładowa konfiguracja (odczyt temperatury i ciśnienia):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read
Data Size: 5 
Master Data Start Address: np.: R415 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401208 (docelowy adres w module)

 5.3 Przykład podłączenia modułu do panelu HMI

Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port
w  panelu  HMI.  Możemy  tego  dokonać  za  pomocą  programu   EasyBuilder  8000.

Wybieramy z menu Edit → System Parameters….
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Rys. 5.9: Okno do dodawania urządzeń podłączanych do panelu HMI
Następnie klikamy na New…, w efekcie czego pojawi się okno jak na rysunku poniżej:

Rys. 5.10: Okno do edycji parametrów komunikacji

Możemy teraz ustawić parametry komunikacyjne urządzenia. Chcąc połączyć moduł z panelem po
magistrali Modbus, należy w danych polach wybrać:

PLC type - tryb komunikacji: MODBUS RTU
PLC I/F - typ portu, po którym będzie

odbywać się komunikacja:
RS-485 2W

PLC default station no.:
adres sprzętowy modułu 

pomiaru ciśnienia i temperatury

COM:
numer i ustawienia portu, przez który odbywa

się komunikacja panelu HMI z modułem.
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Aby ustawić te parametry, należy kliknąć na pole Settings… i wybrać odpowiednie wartości:

 COM (numer portu komunikacyjnego): COM 1

 Baud rate (prędkość komunikacji): 57600 
 Data bits (ilość bitów danych) 8
 Parity (parzystość): Even
 Stop bits (ilość bitów stopu): 1

Rys. 5.11: Ustawienia portu komunikacyjnego

Przykładowa konfiguracja:

 Odczyt temperatury (lub ciśnienia):

Aby odczytywać żądaną wartość z modułu,  należy utworzyć odpowiedni obiekt w panelu HMI
wyświetlający tę wartość. 

W tym celu wybieramy: menu Objects → Numeric/ASCII → Numeric Display
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Pojawi  się  okno  Numeric  Display  Object’s  Properties,  w  którym  w celu  odczytu  temperatury
należy:

W zakładce „General” wybrać:
 Description (własny opis obiektu)

 PLC name: MODBUS RTU
 Device type: 4x
 Address (numer rejestru, który chcemy odczytać- patrz strona 7): 1204

(1204 dla temperatury,  1206 dla ciśnienia)
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Rys. 5.12: Tworzenie obiektu Numeric Display



Rys. 5.13: Właściwości obiektu Numeric Display

W zakładce „Numeric Format” należy wybrać:
• Data Format: 32-bit Float

• Mask: Odznaczyć
• Left of decimal Pt: 3  (część całkowita)
• Right of decimal Pt: 4  (część ułamkowa)

Po zatwierdzeniu ustawień możemy ulokować obiekt w dowolnym miejscu przestrzeni roboczej
programu  EasyBuilder.  Po  załadowaniu  programu  do  panelu  HMI  można  już  odczytywać
temperaturę. 

W celu zmiany wielkości okresu próbkowania należy wykonać tę samą procedurę co powyżej, z tą
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Rys. 5.14: Właściwości obiektu Numeric Display



różnicą,  że  nie  wybieramy już  obiektu  wyświetlającego  dane,  tylko  obiekt  odpowiedzialny  za
wpisywanie danych, czyli „Numeric Input”. W skrócie:

W zakładce „General” wybrać:

• Description (własny opis obiektu)
• PLC name: MODBUS RTU
• Device type: 4x
• Address (numer rejestru przechowujący czas między odczytem): 1203

Rys. 5.15: Właściwości obiektu Numeric Display

W zakładce„Numeric Format” należy wybrać:

• Data Format: 16-bit Unsigned

• Mask: Odznaczyć

• Left of decimal Pt: 3 

• Right of decimal Pt: 0 
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Rys. 5.16: Właściwości obiektu Numeric Display
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6  Wymiary modułu pomiaru ciśnienia MCP-1P

Na  rysunku  poniżej  pokazano  wymiary  obudowy  modułu  pomiaru  ciśnienia.  Obudowa  jest
przystosowana do montażu w puszce elektroinstalacyjnej φ 60.

Uwagi końcowe

• Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń.
• Produkt może nieznacznie różnić się od fotografii.
• Instrukcja  może zawierać  błędy.  Producent  nie  odpowiada za  jakiekolwiek uszkodzenia,

które  mogą  z  nich  wyniknąć.  Jednocześnie  producent  oświadcza,  że  dołoży  wszelkich
starań, by żadne błędy w instrukcji się nie pojawiły, a jeżeli tak się stanie, to informacje o
wszelkich błędach zamieści na swojej stronie internetowej. 

• Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia.
• Aktualna wersja instrukcji znajduje się na stronie www.e-tronix.eu .
• Wszelkie  uwagi  dotyczące  urządzenia  oraz  tej  instrukcji  oraz  pytania  w  sprawach

technicznych nie wyjaśnionych wyżej proszę kierować na e-mail: e-tronix@e-tronix.eu.
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Rys. 6.1: Wymiary obudowy
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